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Prosli put smo malo naceli 3D svijet unutar Photoshopa. Uz novi Photoshop
CS5 i 64-hitnu arhitekturu, sinergija trodimenzionalne i hitmap grafike jos je
jednostavnija. No, hajdemo jo$ malo zaviriti u skrivene kutke dobre stare CS4,
koja nam moze izvuci jo$ pokoji adut iz rukava

pise: Dejan Bari¢

d prili¢no dosadnog i ¢isto temeljnoga
kvadrata u 3D okruzenju, u proslom smo
nastavku uspjeli napraviti zanimljiv prizor
i usredotociti se na neke od elementarnih
pogodnosti 3D elemenata unutar rada s
2D bitmap grafikom. Izometrijsko upravljanje, reali-
sti¢ni odrazi i manipulacija svjetlom svakako su nam
pri vrhu interesa u stvaranju trodimenzionalnih ele-
menata unutar Photoshopova .psd dokumenta.

I ovaj put ¢emo iskoristiti i ponoviti neke ve¢ u
proslom tutorialu naucene korake, ali ¢emo se i malo
dalje otisnuti u 3D svijet te otkriti jo$ neke od skri-
venih mogu¢nosti 3D modeliranja. Pa iako nam je
pozornost usmjerena prvenstveno na osnovinu i
vidljivu teksturu koju lijepimo na trodimenzionalni
objekt, poigrat ¢emo se i zakonitostima bump mapin-
ga, odnosno vidjeti kako se gradacija kod 2D teksture

na vrlo zanimljiv na¢in odraZava pri kreiranju trodi-
menzionalnog elementa.

Kako bismo cijeloj pri¢i dali neki zaokruzeni
smisao, nastavit ¢emo s prizorima hrvatske nam
metropole. Zato ¢emo ovoj tutorial koji, iako seze
u 3D ilustraciju u sebi sadrzi mnoge od elemenata
fotografije, posvetiti velikanu hrvatske, a posebno
zagrebacke fotografije - Teodoru Tosi Dabcu - neos-
pornomu zanatskom i umjetnickom velikanu, koji je
svojim fotografijama dobrano zaduzio jednu od naj-
podcjenjenijih umjetnosti u Lijepoj Nasoj, ali nam
ujedno i ostavio neprocjenjiv dokumentaristicki trag
svoga vremena. Vise o tom velikanu nase inspiracije
moZete procitati u posebnom okviru, a sada se baca-
mo na srZ problema, i uz par snimljenih fotografija s
prizorima metropole kre¢emo u zanimljivu avanturu
kreiranja 3D fotografske ilustracije.
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Odabir
1 Za pocetak ¢emo se pouzdati u Adobe
Bridge, multimedijalni preglednik ugni-
jezden uz Photoshop. Pomoc¢u Bridgea lako ¢emo
unaprijed izabrati fotografije s vizurama grada,
koje ¢e nam par koraka kasnije koristiti u nagem
Photoshop dizajnu.

Prvi, novi dokument
2 Prvi dokument koji ¢emo napraviti

oponasat ¢e nam traku klasi¢noga foto-
grafskog filma u Lajka formatu (35mm). Valjda ne
treba napominjati putanju File->New (Ctrl+N) kako
bismo stvorili novi dokument, jel da? Odabrat ¢emo
veli¢inu dokumenta 32x7 centimetara pri 300 dpi
rezolucije, ali ¢emo selektirati i 16-bitnu boju. Pri
16-bitnom radu mnogi filtri nam nece raditi, ali to
nam je sada nevazno jer nam i dalje radi sve $to je
potrebno.

Gradacija
U ovom koraku otkrit ¢emo jednu vrlo
zabavnu osobinu 3D modeliranja u

Photoshopu, u kojoj se oponasa na¢in Bump map-
ping teksturiranja. No, krenimo redom. Prvo nam
valja izabrati Gradient tool (G). Povudi ¢emo linear-
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nu gradaciju, a boje nasega gradijenta mozemo pro-
nadi slozene u samom Photoshopu; dovoljno je otici
gore u opcije alata ili jednostavno desnim klikom
otvoriti arhiv gradijenta i izabrati Copper gradijent.
Od pocetka do kraja dokumenta valja vodoravno

povudi nasu bakrenu gradaciju.
4 > Iz ravne gradacijske trake, na vrlo jedno-
stavan nacin, dobit ¢emo traku zakriv-
lienu u prostoru. Jednostavno iskoristimo putanju u
izborniku 3D i pronademo opciju New Mesh from
Grayscale pa odaberemo Plane. Photoshop Ce pre-
baciti traku u trodimenzionalni prostor. Svjetliji gra-
dacijski elementi bit ¢e nam ispred, dok ¢e oni tamni-

ji, savinuti u prostoru, biti gurnuti u pozadinu.
5 > Nakon trake, koja ¢e nam postati tra-
kom filma, treba napraviti i dokument u
kojem ¢emo srediti cjelokupan dizajn. Znaci, ponov-
no se vratamo na File->New (Ctrl+N) kako bismo
stvorili novi dokument, ovaj put veli¢ine 20x13 cen-
timetara pri 300 dpi rezolucije i uz 16-bitnu boju.
U novonastali dokument, iza Layer palete, ubacit
¢emo nasu 3D traku. Jednostavno kliknemo na layer
i povu¢emo ga u novi radni dokument. To je, zbog
samog renderiranja, mnogo jednostavniji na¢in nego
da sam objekt bacamo u novi dokument, pa ¢ak i ako

imate moc¢nije ra¢unalo.
6 > Traku koju smo bacili u novi dokument
sada moramo usmjeriti i namjestiti da
nam pristaje uz samu ideju dizajna koji namjerava-
mo ostvariti. Kako bismo ga usmjerili i namjestili
u prostoru, koristit ¢emo 3D Object Slide Tool (K).
Ukoliko kliknemo i vu¢emo, mo¢i ¢emo odrediti
veli¢inu, odnosno blizinu objekta. Pomocu troboj-
nog alata X,Y,Z osi mozemo dodatno po Zelji mani-
pulirati na$im objektom.

7>

Prebacivanje u 3D

Radni dokument

NamjeStanje

Gradient pozadine
Kako nam sama pozadina ne bi ostala
nezanimljivo bijela, i nju ¢emo ukrasiti

gradijentom. Selektirav$i prethodno Background
sloj u Layer paleti, odabrat ¢emo ponovno Gradient
tool (G). Selektiravsi opcije gradijenta na statusnoj
traci alata, moZemo sami stvoriti svoj prijelaz boja.
Za ovu priliku odabrali smo svjetliju i tamniju vari-
jaciju plave boje s bijelom bojom u sredini. Sada je
jos samo potrebno povuéi pravac gradijenta kako bi
nam bijela boja prevladavala oko sredine slike.

Filmska traka
8 > Nasa bakrena traka i nije nam posebno
atraktivna, stoga je vrijeme da joj napo-
kon dodamo pravu teksturu. Lijepiti fotografije na
traku u perspektivi bilo bi frustriraju¢e komplicirano,
zato ¢emo iskoristiti sve ¢ari trodimenzionalne mani-
pulacije. Prvi zadatak nam je domoci se teksture koja
je zalijepljena na nasu trodimenzionalnu traku, a to
je jo$ uvijek ovaj bakreni gradijent. U sloju u kojem
se na$a 3D traka nalazi imamo i podsloj Teksture, koji
nosi identi¢no ime kao i sam sloj. On nam je ovdje
paradoksalno nazvan Background jer smo taj Layer
doslovno povukli iz njegova mati¢nog dokumenta.
No, ukoliko dvokliknemo na Naziv Background,
ispod podsloja teksture otvorit ¢e nam se novi doku-
ment Layer01.psb. Sve vizualne promjene koje ¢emo
sada vrsiti u njemu, odraZavat Ce se na izgledu nase

trodimenzionalne trake. Pa krenimo.
U naSem Layer0l.psb dokumentu

9: rije$imo se prvo bakrene gradacije.

Kombinacijom tipaka D pa X bit ¢emo sigurni da
nam je Background boja - crna - pa mozemo na

Perforacija

WWW.VIDILAB.COM

brzinu i obojiti cijelu povrsinu ukoliko kliknemo
Ctrl+Backspace na tipkovnici. Sada ¢emo prvo
napraviti perforacije na filmu, dakle male bijele
kvadrati¢e na vrhu i dnu filmske trake. U novom
Layeru, pomoc¢u Rectangular Marquee Toola (M),
selektirat ¢emo mali kvadrati¢. Klikom na tipku
D vra¢amo bijelu boju kao Background i ponovno
kliknemo Ctrl+Backspace kako bismo ga obojili u
bijelo. Drzeci tipke A#l + Shift, okomito valja povuci
kvadrati¢ prema dolje kako bismo ga udvostrucili na

dno

UmnoZavanje rupica
1 0 > Dobili smo prvi par rupica na filmu,

ali njima moramo sada ispuniti
cijelu traku. Ukoliko kliknemo na tipke Ctrl+Atl+T,
dobit ¢emo kopiju nasih rupica koje ¢ekaju da ih
smjestimo. To ¢emo najjednostavnije u¢initi tako da
drzimo tipku Shift i uz tipku desne kursorske streli-
ce mi¢emo kopije kvadrati¢a udesno. Za to ¢e nam,
uz drzanje Shifta, trebati i otprilike 10-15 klikova po
desnoj kursorskoj tipki. Kada smo zadovoljni polo-
Zajem, potrebno je kliknuti na tipku Enter. Kako ne
bismo iznova trebali ponavljati ba$ cijeli postupak,
trebali bismo malo zaposliti prste i odjednom kli-
knuti i drzati tipke Shift+Ctrl+Alf, te potom klikati
po tipki T koja ¢e pomaknuti i umnoziti par kvadra-
ti¢a kad god je stisnemo. I tako sve dok ne ispunimo
cijelu duzinu trake.

Okvir slike
> Napravimo najprije novi sloj. Kako
bismo se lak$e kasnije snalazi-

li, mozemo ga u Layer paleti jednostavno nazvati
,Okvir®. Pritiskom na tipku D osigurat ¢emo da
Foreground boja bude bijela. Zatim ¢emo izabrati
Rounded Rectangle tool (U). Gore u statusnoj traci
svakako moramo opcije alata postaviti na Fill Pixels,
jer éemo na taj nacin moci napraviti zaobljeni kva-
drati¢ sli¢ice filma. Stavimo li kursor u gornji lijevi
kut, tek malo ispod kvadrati¢a perforacije koje smo
nacdinili u prosloj tocki, dovoljno je kliknuti, drzati
tipku misa i vudi kursor prema donjoj desnoj strani i
stati tek malo prije kvadrati¢a donje perforacije. Tako
smo dobili prostor na filmu u koji ¢e nam naknadno

=
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Toso Dahac - velikan s fotokamerom

Jednu malenu zemlju koja stremi ka
ulasku u globalnu europsku zajednicu i zeli
se napokon svrstati u okrilie europske
kulture, iako nema ni institucije za akadem-
sko fotografsko $kolovanje, neopisivo je
zaduZio jedan, u pocetku tek entuzijasti¢an
fotograf. lako se fotografija u Hrvatskoj u
pocetku razvila tek kao igracka bogatih
madarskih grofova, u vremenu izmedu dva
velika svjetska rata, unato€ globalnoj svjet-
skoj krizi, Hrvatska i Zagreb bili su itekako
povezani sa svijetom. Teodor ToSo Dabac nakon druge godi-
ne prava napusta studij i zapoSljava se kao prevoditelj filmova
te uskoro pocinje raditi za Metro Goldwyn Mayer; a 1928.
dobiva od oca svoj prvi fotografski aparat.

Tri godine kasnije ToSo ima prvu izlozbu i od tada se
potpuno posvecuje fotografiji pa uskoro slijede i izlozbe u
Pragu, Philadelphiji, Luzernu, Antwerpenu, Becu, Ljubljani,
Frankfurtu, Munchenu, New Yorku i dakako, Zagrebu.
Nijegov glavni motiv, najveca ljubav, postaje grad Zagreb.
Tosine slike postale su nasim simbolima. Nitko nikad prije i
poslije njega nije tako lijepo vidio Zagreb kao $to je to vidio
Dabac. Njegove su slike izvedbom i izgledom besprijekor-
ne, a u nasljede nam je ostavio duh i stvarne prizore jedno-
ga virulentnog vremena, od velike svjetske krize, preko
Drugoga svjetskog rata pa sve do druge polovice prosloga
nam stoljeca.

Poslije Drugoga svjetskog rata, tadasnja Jugoslovenska
vlada angaZirala ga je za snimanje fotografija Sirom Lijepe

Nase. Snimao je i impozantne fotografije
Rijeke i Istre kao dokaz u procesu pro UN, u
kojem je Hrvatska trebala dokazati svoje
postojanje na tim prostorima kako ne bi pri-
pali Italiji. Tosi su se bez presedana divili i
najvedi fotografi, kao i najvedi teoreticari
fotografije. ToSin status medu svjetskim kole-
gama odavno je dosegao kultni status.
| Njegov Atelje bio je stjeciste mnogih genera-
cija fotografa, mnogi od njih njegovi su "idej-
ni" ucenici. |za sebe ostavio nam je brojne
neprocjenjive prizore iz Zivota Zagreba i dijelova Hrvatske,
pa i Sire, a procjenjuje se da postoji barem stotinjak tisuc¢a
fotografija i dijapozitiva koji nikad nisu ugledali svjetlo dana.
Toso Dabac umro je 1970. godine u Zagrebu. Iza sebe osta-
vio je neprocjenjivo fotografsko blago i neizmjerno zaduzio
hrvatsku fotografiju. MoZzemo se samo nadati da ¢emo ga
jednoga dana, kao i samu fotografiju, mo¢i cijeniti kao pravu
umjetnost, kako to rade i sve civilizirane zemlje.

Jer, ipak se nesto krece. Tako smo ove godinu u Muzeju
suvremene umijetnosti mogli prisustvovati drugim ,,Danima
fotografije Arhiva ToSo Dabac*, a BLUR magazin organizirao
je i veliki fotografski natjecaj u ¢ast Dabca, pod nazivom
,Zagreb nekad i sada®, u kojem su fotografi imali za cilj sni-
miti danasnje prizore Zagreba po predlosku Tosinih legen-
darnih fotografija Zagreba iz 30-ih godina proslog stoljec¢a.
Fotografski magazin BLUR napravio je i internetsku stranicu
te uspio prikupiti brojne Dabceve fotografije. Svakako ih
razgledajte na adresi http://www.tosodabac.com/.

do¢i fotografije. Sada bismo trebali ponoviti postu-
pak kopiranja zaobljenih kvadrati¢a. Dakle, prvo
kombinacijom tipaka Ctrl+Atl+T napravimo kopiju
koju moram smjestiti desno pokraj prvog okvira, a
zatim ponovno Kliknuti i drzati tipke Shift+Ctrl+Alf,
te potom kliknuti par puta tipku T kako bismo napra-
vili jo§ par kvadratica koji ¢e popuniti prostor trake.

Fotografije na filmu
> Nadam se da niste zaboravili na onih
pet fotografija koje smo odabrali na

T ]

samom pocetku nase Photoshop avanture. Sada je
na njih red i jednu po jednu ¢emo ubaciti u ovaj nag
dokument. Svi slojevi okvira zovu nam se ,,Okvir®
pa jo$ neki prefiks s obzirom na redoslijed kopije.
Pomodi ¢e nam ukoliko im modificiramo imena u
LOkvir 15 ,Okvir 2¢ ...itd. Uz jasno oznacen redosli-
jed okvira, vrlo lako ¢emo mo¢i znati gdje bi treba-
le dodi i fotografije. Pa krenimo od prve. Valja nam
selektirati Layer prvog okvira, odnosno ,,Okvirl i u
dokument ubaciti i prvu Zeljenu fotografiju, a ona ¢e
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Uz kraticu na tipkovnici Ctrl+T aktivirat ¢emo opci-
ju Free Transform i sada vrlo jednostavno mozemo
veli¢inu slike prilagoditi veli¢ini okvira, s tim da bi
nam sama slika trebala biti nesto ve¢a. Kada smo
zadovoljni polozajem, obratimo pozornost na Layer
paletu i, drze¢i tipku Alt, kliknemo izmedu sloja
okvira i sloja sa slikom. Nasa slika izravno se pove-
zala s oblikom okvira ispod koje je zamaskirao sve
osim svoga oblika te nam se fotografija sasvim fino
stopila u sliku. Istu stvar valja napraviti i s ostalim
fotografijama.

BuSenje rupica
> Dok smo jo$ uvijek na dokumentu
teksture, iskoristit ¢emo priliku da

napravimo njegovu kopiju kroz putanju Image ->
Duplicate. Pojavit ¢e nam se opcija s imenom novog
dokumenta i ,,Maska“ ¢e sasvim posluziti svrsi.
Novostvorenoj kopiji za pocetak je potrebno u Layer
paleti, u gornjem desnom kutu, kroz izbornik opcija
selektirati Flatten Irmage, Sto Ce spojiti sve slojeve. A
zatim posegnuti za Rectangular Marquee Toolom
(M) i obuhvatiti njime okvire sa slikama u srediti
pazedi da ne selektiramo i rupice s perforacijama.
Nacinjenu selekciju zatim je potrebno obojiti u crno,
najjednostavnije uz pomo¢ Background boje i tipaka
Ctrl+Backspace.

Za kraj jo§ valja iskoristiti putanju Image-
>Adjustment->Invert (ili jednostavnije Ctrl-I), $to
¢e nam stvoriti negativ-uc¢inak. Taj dokument sada
mozemo spremiti, recimo na Desktop. Maska.psb bit
¢e sasvim OK ime.

Svjetlo
1 4 > Napokon je vrijeme da se vratimo

na na$ radni dokument na kojem
¢e nas, nakon par trenutaka, docekati novi izgled
trake u 3D prostoru. Ovo nam je posljednja prili-
ka da po potrebi jo§ malo popravimo smjestaj nase
trake u prostoru pomo¢u 3D Object Slide Tool (K).
Alj, ba$ kako moZemo pomicati sam objekt u pro-
storu tako mozemo pomicati i svjetla koja okruzuju
i osvjetljuju objekt, sto se uvelike odrazava na izgled
i teksturu nase trake. U izborniku Windows pozvat
¢emo panel 3D. U njemu ¢emo pronaci najvaznije
stvari koje se ti¢cu manipulacije nasim trodimenzi-
onalnim objektom. Ono $to nas konkretno ovdje
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zanima jest u izborniku pod Scene —> Infinite light.
Naime, ovdje mozemo eksperimentirati, dodavati i
oduzimati izvore svjetla uz razli¢ite nac¢ine manife-
stiranja i intenziteta. Nama je u ovom trenutku naj-
vaznija zadaca selekcije prvoga svjetla i odabir alata
za pomicanje i okretanje izvora svjetla, pa ¢emo tako
odabrati Rotate the Light tool i pokusati usmjeriti u
najbolju poziciju s obzirom na odrazavanje svjetla na
nasoj traci. Ovo je zadatak koji ovisi i o polozaju 3D
elementa, stoga je potrebno i malo eksperimentirati.

Prozirnost
> Dok smo jos pri 3D panelu, rijesit
¢emo se neugodne bjeline unutar

perforacije filma i u¢initi ga ipak malo vjerodostoj-
nijim. Tre¢i gumb gore na 3D panelu zove nam se
Filter by Materials i njegovim aktiviranjem pre-
bacit ¢emo se u 3D Materijals mod. Tu nas sada
zanima stavka Opacity. Ta stavka uza se ima gumb
za dodatni izbornik iz kojega valja selektirati Load
Texture opciju. Otvorit ¢e nam se Explorer u kojem
trebamo pronaci odredenu teksturu koju Zelimo udi-
tati. Mi ¢emo ucitati onu teksturu Maska.psb, koju
smo brizljivo spremili jo$ u 13. koraku. I ¢im smo to
napravili, rupice perforacije filma trebale bi postati
—providne!

Refleksija
> Jos u proslom tutorialu otkrili smo
odli¢nu metodu simuliranja reflek-

sije pomocu trodimenzionalnih objekata, stoga bi
zaista bila prava $teta da taj mali trik ne ponovimo
i ovdje. Dakle, prvo moramo udvostruciti layer s
nasim 3D objektom (Ctrl+]) , a zatim selektirati
ponovno onaj originalni koji ¢e se sada nalaziti ispod
novonastaloga. Pomocu alata 3D Object Slide tool
(K) po Z osi (plava strelica) spustit ¢emo povlace-
njem misa traku filma, ravno dolje do mjesta gdje se
nalazi dno kopirane trake filma.

Okretanje refleksije
> S refleksijom dakako jo§ nismo
zavr$ili, jer nam jo$ uvijek ne djelu-

je kao takva. Prvo moramo izokrenuti cijelu tekstu-
ru donje trake filma. Za to u Layer paleti ponovno
selektiramo donji sloj s nasim filmom i uputimo dvo-
klik na ,Background” sloj ispod podsloja teksture
kako bi nam se ponovo otvorio dokument Layer01.
psb. Dokument s teksturom filma i dalje u sebi sadrzi
mno$tvo slojeva pa da se ne bismo suvise optereciva-
li njima, jednostavno ¢emo slijediti putanju; Image-
>Image Rotation-> Flip Canvas Vertical. Nakon
toga mozemo se vratiti u na$ radni dokument.

Providna maska
> Kad smo uspjesno okrenuli tekstu-
ru, poigrat ¢emo se malo i samom

vidljivo$¢u refleksije. U nasem radom dokumentu

ponovno usmjerimo pozornost na Layer paletu, no
ovaj put na sloju refleksne trake valja dvokliknuti u
dijelu tekstura Opacity, odnosno ondje gdje nam je
ispisano ime Maska. Tada ¢e nam se otvoriti Maskal.
psb dokument. Maske funkcioniraju na nadin da
nam prikazuju na slici sve $to je na njihovoj povrsini
u bijeloj boji, a skrivaju sve $to je u crnim podru;ji-
ma. Kako bismo stvorili efekt laganog izbljedivanja,
napravit ¢emo novi Layer iznad Background sloja u
Maskal.psb dokumentu. U tom novom sloju upora-
bit éemo Gradient tool (G). U opcijama gradijenta
izabrat ¢emo drugi gradijent po redu ; Foreground
to transparent. S obzirom da nam je potreban crni
gradijent ka prozirnom i Foreground boja bi treba-
la biti crna. Zatim povucemo gradacijski sloj malo
iznad dna trake pa prema vrhu. Za kraj kliknemo
Ctrl+S kako bismo sacuvali promjenu i mozemo
ugasiti Maskal.psb dokument.

Renderiranje!
1 9 > Pri kraju smo pa mozemo jo$ malo

iskoristiti 3D panel. Oznaliti valja
cjelokupan objekt selekcijom na Scene, a zatim posta-
viti prikaz sa Draft na BEST, ili Ray Traced final ako
ve¢ koristite novi Photoshop CS5. To ¢e vam na neko
vrijeme zaposliti ra¢unalo dok Photoshop ponovo ne
ispise sliku, dio po dio. 3D objekt tako ¢e postati ravan
i o8triji bez ruznih iskrzanih piksela. To renderiranje
i Anti-Aliasing potrajat ée neko vrijeme, posebno ako
imate slabije ra¢unalo pa ¢e biti potrebno i malo str-
pljenja. Ili malo vise strpljena. Deja Vu.

Fotofinis!
> Josjednu3DavanturuuPhotoshopu
priveli smo kraju. Uvijek mozemo

pridodati jo$ koji zanimljiv detalj koji bi upotpunio

ADOBE PHOTOSHOP TUTORIAL

cjelokupnu sliku. Na zalost, nemamo dovoljno pro-
stora nauciti vas kako snimiti zanimljive fotografije
svoga grada ili mjesta, ali mozemo predloziti par
ideja $to napraviti sa tim fotografijama poslije.

Ne zaboravite da je To$o Dabac umjesto
Photoshopa imao samo tamnu komoru pa opet nas
i danas odusevljava svojim vjecnim fotografijama
koje su postale neprocjenjiv prozor u povijest ,,Lijepe
Nase® Ono $to je i Dabac tada imao uza svoju foto-
grafsku kameru, svakako je duh istrazivanja i igranja
pri biljezenju svakodnevnice. Stoga mudro iskoristite
Photoshop kao vrlo koristan fotografski alat, istrazu-
jete, igrajte se i uZivajte!
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